Programme: VLT

Project/WP: Science Operations

FPOSS USER MANUAL

Document Number: ESO-281178

Document Version: 3.5

Document Type: Manual (MAN)

Released On:

Document Classification: Public

Prepared by:

Validated by:

Approved by:

Name
### Authors

<table>
<thead>
<tr>
<th>Name</th>
<th>Affiliation</th>
</tr>
</thead>
<tbody>
<tr>
<td>A.Kaufer</td>
<td>ESO</td>
</tr>
<tr>
<td>C. Melo</td>
<td>ESO</td>
</tr>
<tr>
<td>D.Naef</td>
<td>ESO</td>
</tr>
<tr>
<td>J.Smoker</td>
<td>ESO</td>
</tr>
<tr>
<td>D. Gadotti</td>
<td>ESO</td>
</tr>
<tr>
<td>B. Häußler</td>
<td>ESO</td>
</tr>
</tbody>
</table>

### Change Record from previous Version

<table>
<thead>
<tr>
<th>Issue / Revision</th>
<th>Date</th>
<th>Section / Page affected</th>
<th>Reason / Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>29/09/1999</td>
<td>All</td>
<td>First Issue – preliminary</td>
</tr>
<tr>
<td>1.1</td>
<td>25/09/2001</td>
<td>All</td>
<td>PAA version</td>
</tr>
<tr>
<td>1.2</td>
<td>25/11/2001</td>
<td>Most</td>
<td>PAA(B) preliminary version</td>
</tr>
<tr>
<td>1.3</td>
<td>14/02/2002</td>
<td>Most</td>
<td>First released version</td>
</tr>
<tr>
<td>1.4</td>
<td>14/02/2002</td>
<td>3.8,6,14,9,7</td>
<td>Minor changes relating to PAF file names</td>
</tr>
<tr>
<td>1.5</td>
<td>30/08/2002</td>
<td>7</td>
<td>Updated distribution details</td>
</tr>
<tr>
<td>1.6</td>
<td>23/11/2002</td>
<td>Most</td>
<td>Small revisions for ESO distribution</td>
</tr>
<tr>
<td>1.7</td>
<td>24/11/2002</td>
<td>Most</td>
<td>Document taken over from K.Shortridge. Paranalization 1: Updates for first user release. Corresponds to FPOSS version 1.20</td>
</tr>
<tr>
<td>1.8</td>
<td>21/12/2002</td>
<td>8.5</td>
<td>Updates for FPOSS include. version 1.24</td>
</tr>
<tr>
<td>1.9</td>
<td>03/02/2003</td>
<td>Several, A Section 1, p5</td>
<td>Updates for FPOSS include. version 1.31</td>
</tr>
<tr>
<td>2.0</td>
<td>17/07/2004</td>
<td></td>
<td>Minor change, only the Linux version of FPOSS is released to the community</td>
</tr>
<tr>
<td>3.0</td>
<td>25/11/2004</td>
<td></td>
<td>Minor change to note that FPOSS now creates a checksum to prevent editing of INS files</td>
</tr>
<tr>
<td>79.0</td>
<td>01/09/2006</td>
<td>None</td>
<td>Version number updated</td>
</tr>
<tr>
<td>80.0</td>
<td>27/02/2007</td>
<td>None</td>
<td>Version number updated</td>
</tr>
<tr>
<td>81.0</td>
<td>26/08/2007</td>
<td>None</td>
<td>Version number updated</td>
</tr>
<tr>
<td>82.0</td>
<td>08/03/2008</td>
<td>None</td>
<td>Version number updated</td>
</tr>
<tr>
<td>Doc.</td>
<td>Date</td>
<td>Notes</td>
<td></td>
</tr>
<tr>
<td>------</td>
<td>------------</td>
<td>--------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>82.1</td>
<td>08/03/2008</td>
<td>Minor bug corrected</td>
<td></td>
</tr>
<tr>
<td>82.2</td>
<td>08/03/2008</td>
<td>Minor bug corrected</td>
<td></td>
</tr>
<tr>
<td>82.3</td>
<td>08/03/2008</td>
<td>Minor bug corrected</td>
<td></td>
</tr>
<tr>
<td>83.0</td>
<td>08/09/2008</td>
<td>Version number updated</td>
<td></td>
</tr>
<tr>
<td>83.1</td>
<td>25/11/2008</td>
<td>Minor bugs corrected</td>
<td></td>
</tr>
<tr>
<td>84.0</td>
<td>25/02/2009</td>
<td>Minor changes</td>
<td></td>
</tr>
<tr>
<td>85.0</td>
<td>28/08/2009</td>
<td>Minor changes. VLT guide star magnitude</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>range amended</td>
<td></td>
</tr>
<tr>
<td>87.0</td>
<td>25/08/2010</td>
<td>None</td>
<td></td>
</tr>
<tr>
<td>88.0</td>
<td>01/03/2011</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>89.0</td>
<td>30/08/2011</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>90.0</td>
<td>24/02/2012</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>91.0</td>
<td>01/09/2012</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>92.0</td>
<td>06/03/2012</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>93.0</td>
<td>09/09/2013</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>94.0</td>
<td>27/02/2014</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>94</td>
<td>24/04/2014</td>
<td>Version updated</td>
<td></td>
</tr>
<tr>
<td>98</td>
<td>11/07/2016</td>
<td>Notes on new FPOSS version fixes</td>
<td></td>
</tr>
<tr>
<td>106</td>
<td>15/05/2020</td>
<td>p2pp-&gt;p2, mentioning FCMaker</td>
<td></td>
</tr>
<tr>
<td>107</td>
<td>21/7/2020</td>
<td>VLT Guide Star magnitude limits changed for ARGUS</td>
<td></td>
</tr>
</tbody>
</table>
# Contents

1 Introduction .......................................................................................................................... 6  
1.1 Purpose ............................................................................................................................... 6  
1.2 Scope ................................................................................................................................. 6  
1.3 Reference Documents ........................................................................................................ 7  
1.4 Abbreviations and Acronyms ............................................................................................ 7  
1.5 Nomenclature .................................................................................................................... 7  
2 Overview ................................................................................................................................ 9  
2.1 Known features and bugs ................................................................................................. 9  
2.1.1 Instrumental changes .................................................................................................... 9  
2.1.2 Operational procedure changes .................................................................................. 10  
2.1.3 Software features and bugs ....................................................................................... 10  
2.1.3.1 No angle and/or scale parameters in ARGUS setup files ................................... 10  
3 Using FPOSS ....................................................................................................................... 11  
3.1 Initial preparations ............................................................................................................ 11  
3.2 Preparing the input file ..................................................................................................... 13  
3.2.1 Proper Motion ............................................................................................................. 13  
3.3 Running FPOSS ............................................................................................................... 14  
3.4 Reading in a target file ...................................................................................................... 15  
3.5 Selecting a VLT guide star ............................................................................................... 15  
3.6 Specify the fibre combination ........................................................................................... 16  
3.7 Perform the allocation ...................................................................................................... 16  
3.8 Check Hour Angle range ............................................................................................... 17  
3.9 Saving the configuration ................................................................................................. 17  
3.10 Exit the program ............................................................................................................ 17  
4 Some additional features ...................................................................................................... 18  
4.1 Using the Mimic window ................................................................................................. 18  
4.2 Different allocation algorithms ...................................................................................... 18  
4.3 Uncrossing fibres ............................................................................................................ 18  
4.4 Multiple configurations to cover a target list ................................................................ 19  
4.5 Viewing allocations using Skycat ................................................................................... 19  
5 Detailed input file format ..................................................................................................... 21  
5.1 Additional items embedded in comments ..................................................................... 22  
5.2 Possible object types ...................................................................................................... 22  
5.3 Example Text Input File ................................................................................................. 23  
6 The FPOSS configuration program ...................................................................................... 24  
6.1 Running the FLAMES configuration program .............................................................. 24
1 Introduction

This manual describes the FPOSS Fibre configuration program written at the AAO as part of the FLAMES project. FPOSS is intended to be run as an adjunct to the p2 process when preparing FLAMES observations. It takes as input a file containing a list of target objects and generates a configuration in which as many fibres as possible are allocated to targets, allowing for the various instrumental constraints and any specified target priorities. It produces a file containing a list of allocations of fibres to targets. This file (which should not be manually edited) can then be attached to one (or more) Observation Block to be generated via p2.

The manual begins with a brief summary of how to use the program, followed by a detailed formal description of the input text file format and of the configuration program. At the very end, an introductory tour of the program takes you through all the details of an allocation from the reading of a supplied input text file to the writing of the output Target Setup file. You may like to run through this when you start to use the program, just to get familiar with the way it works. The appendix provides little that cannot be found in the main body of the manual, apart from a number of illustrations, but some users may find this the most convenient introduction to FPOSS.

FPOSS is run as a standalone program on the observer’s own Linux-based computer system. It is available from ESO under the address:

http://www.eso.org/sci/observing/phase2/SMGuidelines/FPOSS.html

Users should always make sure they are running the latest version of the program as observation blocks prepared using an old version will be rejected. Files produced by FPOSS contain a checksum and p2 will reject files that have been manually edited.

1.1 Purpose

This document serves as the User Manual of the FLAMES fibre configuration software. It has been written for operators of the instrument and astronomers. The reader is assumed to be familiar with the FLAMES instrument.

1.2 Scope

This manual only covers the operation of the FPOSS program itself. It does not cover the FLAMES P2 process, nor does it cover any of the details of observing with FLAMES.
1.3 Reference Documents

The following documents are referenced in this document:


1.4 Abbreviations and Acronyms

The following abbreviations and acronyms are referenced in this document:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2dF</td>
<td>The AAO’s 2 degree Field facility.</td>
</tr>
<tr>
<td>6dF</td>
<td>The AAO’s 6 degree Field facility</td>
</tr>
<tr>
<td>AAO</td>
<td>Anglo-Australian Observatory</td>
</tr>
<tr>
<td>ARGUS</td>
<td>Integral Field Unit (fixed)</td>
</tr>
<tr>
<td>BOB</td>
<td>Broker for Observation Blocks</td>
</tr>
<tr>
<td>FACB</td>
<td>Field Acquisition Coherent Bundle</td>
</tr>
<tr>
<td>FLAMES</td>
<td>The whole Fibre Facility</td>
</tr>
<tr>
<td>FP</td>
<td>Fibre Positioner</td>
</tr>
<tr>
<td>FPOSS</td>
<td>The program described in this document.</td>
</tr>
<tr>
<td>GUI</td>
<td>Graphical User Interface</td>
</tr>
<tr>
<td>OS</td>
<td>Observation Software</td>
</tr>
<tr>
<td>OSS</td>
<td>Observer Support Software</td>
</tr>
<tr>
<td>P2PP</td>
<td>Phase 2 Proposal Preparation Tool</td>
</tr>
<tr>
<td>P2</td>
<td>(new/online) Phase 2 Proposal Preparation Tool</td>
</tr>
<tr>
<td>TCL</td>
<td>Tool Command Language</td>
</tr>
<tr>
<td>TK</td>
<td>Tcl Windowing Toolkit</td>
</tr>
<tr>
<td>VLT</td>
<td>Very Large Telescope</td>
</tr>
</tbody>
</table>

1.5 Nomenclature

Throughout this manual the term 'reference star' is used for a target that is intended to be allocated to one of the FACB guide fibre bundles. The term 'guide star' is only used for a star intended as a target for the VLT guide probe.

Glossary
A glossary of terms specific to the Fibre Positioner is given in the separate document Flames Fibre Positioner, Glossary of Terms [1]
2 Overview

The configuration program is part of the observation preparation software used by a number of instruments built by the AAO. These include the original '2dF', the more recent '6dF' and the 'OzPoz' fibre positioner built for the FLAMES instrument for ESO. The version of this program used with FLAMES is known as FPOSS (Fibre Positioner Observation Support Software). FLAMES (like the other AAO instruments) uses a robotic fibre positioner to place optical fibres in the focal plane of the telescope so that light from a number of target objects may be fed to the spectrograph (or other instruments). FLAMES requires a configuration phase in which the fibres are allocated to targets in such a way that the fibre configuration is physically possible (fibres and the 'buttons' that carry them do not collide, and fibres are not bent past their allowed tolerances, for example), and the best coverage possible is achieved (as few unallocated targets as possible, without any strange artefacts in the distribution of allocated targets, for example). This is the role of the configuration program FPOSS. It takes a text file containing a list of target objects and allocates fibres to these. Fibres can be allocated manually one by one, and/or automatically. Several different allocation optimisation strategies are available for the automatic fibre allocation. It then saves the information to a file that needs to be included in the Observation Block created as part of the P2 process.

The rest of the manual is organised as follows:

- Chapter 3 summarises the use of FPOSS for FLAMES observers.
- Chapter 4 describes some more advanced features of the program.
- Chapter 5 provides information about file formats.
- Chapter 6 provides comprehensive descriptions of program facilities.
- Chapter 7 provides menu guides and explanations.
- Chapter 8 is an appendix that provides an illustrated tour of FPOSS.

2.1 Known features and bugs

The FPOSS software was set at a 'frozen' state and was not updated in the period from December 2006 to July 2016. In this period, a number of changes have been made in the instrument and in the way it is operated and a few bugs have been discovered. Although they have been now mostly fixed, we keep a discussion about them in this section for the purpose of tracking changes in the different FPOSS versions.

2.1.1 Instrumental changes

In 2009, the Acquisition and Guide camera technical CCD was upgraded. The new CCD has better quantum efficiency and a greater dynamic range, but smaller pixels, the end result of which is that the recommended brightness range for the VLT guide stars changed from R=11.0 – 13.0 mag to R=9.0 – 11.0 mag. The VLT guide star is used both for guiding and for the active optics system. If guide stars outside the recommended range are used, while guiding may still be possible (depending on just how much brighter or fainter the guide star is), the active optics system will likely fail altogether or at best function sub-optimally, in either case the resulting image quality achieved by the telescope will be sub-optimal and the expected S/N based on ETC predictions will likely not be achieved.
FPOSS was updated to reflect this change in the recommended brightness range for the VLT guide star. Earlier versions (before P98), however, will produce a warning when a guide star within the currently selected brightness range is selected. This warning should simply be ignored (provided of course the selected guide star really is within the current recommended brightness range).

In July 2020, the faint magnitude limit was changed to R=12 in case of ARGUS observations, as the guide star can be selected closer to the center of the field of view, avoiding vignetting. In such a case, a fainter guide star is possible. The guide star for ARGUS observations is hence required to be in the range R=9.0 – 12.0 mag.

2.1.2 Operational procedure changes
It is possible to select a VLT guide star anywhere within the 28 arcmin diameter field of view centred on the specified field centre coordinates. However, guide stars outside the 25 arcmin diameter field of view will be vignette by the M3 tower of the telescope, which can result in reducing the guide star apparent brightness to a level outside the recommended brightness range, which will thus have an impact on the resulting S/N achieved in the resulting data, as described above. As of ESO observing period 94, guide stars outside the 25 arcmin diameter field of view will no longer be accepted in Service Mode.

The FPOSS software unfortunately gives no warning or error message for stars outside the 25 arcmin diameter field of view. Service Mode users must therefore insure that they themselves select a guide star inside the 25 arcmin diameter field of view, as indicated by the blue circle in the FPOSS mimic display. In case no suitable stars are available within the 25 arcmin diameter field of view it may be possible to re-centre the field in order to bring a suitable star within the 25 arcmin diameter field of view. In visitor mode it is still possible to use guide stars outside the 25 arcmin diameter field of view, but in this case the selected star will in general need to be brighter than the recommended brightness range in order to compensate for the vignetting by the M3 tower.

2.1.3 Software features and bugs

2.1.3.1 No angle and/or scale parameters in ARGUS setup files
When preparing multiple ARGUS setups where all the setups will have the same position angle and image scale settings, it is possible, once these parameters have been set once in the ‘Argus Settings’ window, which only appears after you click Apply in the ‘Select Fibre Combination’ window if you have selected one of the ARGUS modes, to open new input files and create further setups without having to ‘Select Fibre Combination’, the correct Fibre Selection will still be indicated in the ‘FPOSS: Basic Sequence’ window. However, the position angle and image scale parameters will not be written to any resulting FPOSS setup file. P2 will not detect the problem of the missing information but OBs containing such setup files will FAIL during execution at the telescope. The P2 EVM verification script will detect the problem and report an error, so such setup files will be rejected during check-in for service mode runs, however in visitor mode, where it is not required to run the P2 EVM script on each OB, it would be possible for such OBs to arrive to Bob and fail only at the point of execution. Of course it is recommended to always run the P2 verification script on every OB intended to be sent to Bob, even in visitor mode, since this will catch problems such as this one.
In order to avoid this problem, simply remember to explicitly set the Fibre Combination each and every time you load a new input file.

3 Using FPOSS

This section provides a description of how FLAMES observers should use FPOSS to prepare configuration files. This section attempts to be brief; further details can be found in the latter sections of the manual.

3.1 Initial preparations

You need to know the following things:

- Where your target field is: you need to know:
  
  A central position in J2000 coordinates.
  A name for the field.

  The name can be anything you choose. You can modify the field centre position slightly in FPOSS, but you need a good initial position.

- Which FLAMES configuration(s) you intend to use.
- You need to know which combination of fibres you will use for each observation. You need to know if you will use the ARGUS, IFU or Medusa mode fibres and if you will use the UVES fibres or not. If ARGUS is to be used, you need to know the position angle and image scale to be used. Note that not all FLAMES templates need FPOSS input files. In particular the “ARGUS Fast” mode does not require the use of FPOSS as it relies on the VLT guide star only, but is available only in visitor mode.

- What targets you want to observe. You need a list of targets, and for each one you need:

  A name.
  The position in J2000 coordinates.
  The magnitude.
  The target type.
  A priority.

  The magnitudes are recorded in the output files, but are otherwise ignored except for VLT guide probe targets, in which case the magnitude should be
within a specified range. The target type determines what fibre types can be assigned to the target, so you need to know which targets are to be observed with which instrument. Targets of high priority are allocated to fibres in preference to ones of lower priority. Priorities are classified as a numeric code from 0 to 9, with 9 the highest priority.

Typically, most target coordinates will be specified with Epoch/Equinox = 2000.0. As we get further and further from 2000.0, proper motion will have an ever increasing influence on the positions of the targets. Depending on the type of targets and their typical distances, it may thus be important to include proper motion information in the input files.

**The locations of some possible VLT guide stars**

You need to supply the position of at least one star suitable for use as a VLT guide star. Ideally, these should be close to the edge of and within the 25 arcminute diameter field in order to reduce the shadowing of the field by the VLT guide probe and avoid vignetting of the guide star by the M3 tower. Guide stars outside the 25 arcminute diameter field will not be accepted in Service mode. Guide stars need to have magnitudes suitable for use by the VLT guider (R-band magnitude of between ~9-11 (see the FLAMES user manual for details). You will choose one of these during the configuration process.

Given the recommended brightness range for the VLT guide stars, a significant fraction of suitable stars have significant proper motions. Proper motion information should therefore be included in the input file for all potential guide stars.

**The locations of some reference stars**

You also need to supply a number of stars that can be used as reference objects by the FACB guide fibres. At least three of these need to be included in the configuration, so you should supply a number of possible reference stars, arranged throughout the field.

Given the recommended brightness range for the reference stars, a significant fraction of suitable stars have significant proper motions. Proper motion information should therefore be included in the input file for all potential reference stars.

**Some sky positions**

You can handle sky in more than one way, but the most control over sky is obtained by providing explicit sky targets – coordinates that refer to blank sky – in the target list. You can specify that sky targets are only for use by the IFU sky fibres (you might place these close to the IFU targets), or only for use by the ARGUS sky fibres (you might place these close to the main ARGUS aperture in the center of the field), or general sky targets that can be used for any instrument. Alternatively, FPOSS can generate a ‘sky grid’ of possible sky
positions, but it cannot guarantee that these actually represent blank sky. However you allocate sky targets, you should ensure that your configurations have enough sky targets allocated to fibres.

3.2 Preparing the input file

Most of the information listed in the previous section needs to be supplied to FPOSS in a text file. Such files are called '.fld' files, since that is the extension that they use. These can be created using an ordinary editor, but it is more likely that the bulk of the file will be created using a program. The format of the file is detailed in Chapter 5 but it has a short initial section describing the field itself and then a series of lines each one of which describes one target object. (Some of which must describe reference stars and potential VLT guide stars.)

The field details at the start of the file might look like this:

LABEL M67 central field
CENTRE 08 51 22.82  11 50 09.4

And the following might be lines describing individual targets:

M67_00005 08 50 15.98  11 33 58.6  M  1  18.16  1 (B-V)= 0.614
M67_00050 08 51 47.93  11 34 45.6  U  1  15.33  19 (B-V)= 0.321
M67_00097 08 50 38.40  11 35 32.2  I  1  18.06  42 (B-V)= 0.103
U0975_06059928 08 50 18.307  11 55 21.29  G  1  9.40  1052 (PM-RA)=0.01,(PM-DEC)=0.02
U0975_06066823 08 51 23.004  11 49 13.01  F  1 12.30  1093 (PM-RA)=0.05,(PM-DEC)=0.05
SKY_00023 08 51 54.80  11 45 07.8  S  1  99.9  1338
ISKY_0023 08 51 09.81  11 52 14.1  J  1  99.9  1373
ASKY_0001 08 51 10.87  11 42 47.9  A  1  99.9  1374

Each of these sample lines describes a target of a different type, distinguished by the single letter target type code that follows the coordinates. M is a Medusa target, U a UVES target, I is an IFU target, J is an IFU sky target, G is a potential VLT guide star, F is a reference star target for the FACB guide fibre bundles, S is a generic sky target, and A is an ARGUS sky.

It is possible to generate a number of configurations from the same input file. If you intend to observe the same field with different combinations of fibre types you can include the targets for all fibre types in the one file and generate different configurations with different fibre types enabled. If you have a large number of targets in the same field you can put them all in the one file and generate a number of configurations until all the targets have been allocated.

3.2.1 Proper Motion

As most astrometric catalogues are based on an epoch of 2000.0, as time passes the issue of proper-motion becomes increasingly important. If the Guide Star, and/or one or several of the FACB stars has significant (see below) proper motion it can complicate the
acquisition, even to the point of making it impossible to complete the acquisition. Even if the acquisition can be completed, FACB coordinates which fail to account for proper motion may cause the mis-alignment of every target fibre with the sky. Finally even if guide and/or FACB stars have negligible proper motion and/or any significant proper motion is properly accounted for, proper motion of the science targets may cause misalignment of the respective fibres with individual targets.

It is thus strongly recommended to check all targets (guide, FACB and science stars) for proper motion, and where appropriate include the relevant additional information in the FPOSS fld file, to be included in the FPOSS setup file.

You should include proper motion information in the FPOSS fld file for any target whenever the magnitude of the proper motion at the end of the relevant period would exceed 0.1 arcsec (A-ranked programmes may want to consider the magnitude at the end of the relevant period plus 2, to cover the possibility of carryover). For example, for P94 programmes, the end of the period is at 2015.25, therefore check if:

\[(2015.25 - 2000.0) \times \sqrt{(\text{PropRA}^2 + \text{PropDec}^2)} > 0.1 \text{ arcsec}\]

\[15.25 \times \sqrt{(\text{PropRA}^2 + \text{PropDec}^2)} > 0.1 \text{ arcsec}\]

for any of your guide, FACB or science target stars. For P94, this corresponds more or less to proper motions of order of magnitude of 0.003 arcsec/yr or greater, or 3 milli-arcsec/yr.

The inclusion of proper motion information in the FPOSS fld file is described in section 5.1 and examples are included in the example fld files provided in the section above and elsewhere in this manual.

### 3.3 Running FPOSS

Currently the FPOSS software only runs on Linux based systems and furthermore is only fully supported on 32-bit systems. It is generally possible to run FPOSS on 64-bit Linux systems provided the appropriate 32-bit compatibility libraries are installed (typically these are not installed by default in most standard, modern distributions), but even then there are often cosmetic incompatibilities (e.g. oversized fonts) which can make using the software uncomfortable.

The FPOSS software can be downloaded from ESO in a single compressed tar file. Install FPOSS in a directory on your local machine simply by extracting the files from the compressed tar file. Where you choose to do that is up to you. For simplicity here, we assume the directory is in your execution path, so just typing the name of the executable file will run the program. The FPOSS executable is called configure. The most convenient way to run it is probably to have a working directory in which you have your .fld files and in which you will generate your configuration files. If the you have added the <installation-directory>/FPOSS/bin directory to your $PATH environment variable, type
This will start up FPOSS. There is a standard basic sequence that will guide you through the steps needed for a standard configuration. The **Basic sequence** window is shown in Figure 6, and a configuration can be created and saved simply by clicking its buttons in sequential order. (The tour through FPOSS in Chapter 8 shows the user interface in detail as one follows this sequence.) Essentially, you will have to do the following:

- Set a magnitude filter to reduce the number of targets read from the `.fid` file, if necessary.
- Read in the details of a target field from the `.fid` file.
- Select a VLT guide star.
- Specify the fibre combination to be configured.
- Perform the allocation of fibres to targets
- Check the validity.
- Save the resulting configuration in a file.

Each of these steps corresponds to one button in the **Basic sequence** window.

### 3.4 Reading in a target file

The program has no preset limit to the number of targets it can handle, but in practice it starts to run slowly (particularly when displaying) if it is dealing with more than a couple of thousand targets. If you have more targets than that, you should apply a magnitude filter so that only targets in the same magnitude band are handled at one time. (The filter does not apply to reference stars and VLT guide stars.) To apply a magnitude filter, click on the **Magnitude Filter** button in the basic sequence window and enter a pair of limiting magnitudes. Then click on **Apply**.

To read in a target file, click on the **Open input file** button in the **Basic sequence** window. Then select the file (`.fid`) in the file selection dialogue. The field will be displayed, together with all the fibres (cf. Figure 16).

### 3.5 Selecting a VLT guide star

Potential VLT guide stars are shown as bigger open circles, in dark blue. You should select one by double-clicking on it. You then see two blue filled circles that indicate the two possible guide probe pivot positions for that guide star. Click on one of these to select that position. Ideally, the guide star should be selected close to the edge of but inside the 25 arcminute diameter field so as to minimise the shadowing by the guide probe and avoid vignetting by the M3 tower.

(Usually the guide stars can be seen clearly. If you cannot see them, go to the main control panel and select **Select targets…** from the **View** menu. Click the boxes for **VLT guide** and **Highlight using arrows** and click on the **Apply** button.)
Note: The **Select guide star** button in the **Basic sequence** window merely reminds you how to do this and records that you have done so; it doesn’t actually initiate the selection for you, since all you usually have to do is double click on a suitable target.

### 3.6 Specify the fibre combination

Click on **Fibre combination** in the basic sequence window. A list of possible fibre combinations appears (cf. Figure 18). You should select the one you want to use and click **Apply**. Note that the FACB reference fibres are included in all combinations and do not need to be specified explicitly.

If you have selected one of the ARGUS modes, after clicking **Apply**, the **ARGUS Settings** window will appear and you will need to select the required image scale and set the required position angle, then click **Apply** in the **ARGUS Settings** window. You can then click the **Close** button if you like.

### 3.7 Perform the allocation

Click on the **Allocate** button in the **Basic sequence** window. A dialogue window appears (Figure 19) offering you various options that control the details of the allocation process. Usually, the default values will be fine, and all you need to do is click the **OK** button. You should check the number of sky targets that are to be allocated. If you are using fibres that can be allocated to either sky or non-sky targets it is usually best to tell the program explicitly to allocate a certain number of sky targets to each fibre type. If you have too few sky fibres allocated you may not be able to get the best out of your data when you reduce it, especially with faint targets.

Section 6.7 provides more details of the allocation process and explains the various options.

The total number of fibres allocated is shown in the **Basic sequence** window. More details, including the number of fibres allocated to reference stars and to sky targets are shown in the control panel. You should check that you have enough sky and reference targets allocated to fibres.

If the allocation is unsatisfactory for any reason, you can try again with different parameters (in which case you should select **Remove allocations** from the **Commands** menu first). Or you can make minor corrections to the allocation by hand, selecting targets and fibres by clicking on them and then either explicitly allocating and/or deallocating them. This is described in more detail in Section 6.9.
3.8 Check Hour Angle range

The basic sequence described above will usually generate perfectly satisfactory configurations. However, it is highly recommended for all (and required for Service Mode runs) to check the allocation validity over a wide range of hour angle (e.g. -4hrs to +4hrs).

Changes in the hour angle introduce small changes in the position of target objects in the field. FPOSS configures its fields for a specific hour angle. If the actual observation is made under radically different circumstances, the target positions will change and in some circumstances these changes can result in two fibres being positioned too close together, or the maximum bend angle for a fibre being exceeded. FPOSS allocates using more restrictive tolerances for such things as button/fibre clearances and maximum fibre bend angles than does the actual positioner. This means that configurations generated by FPOSS should be valid over a wide range of hour angles and various central wavelength values. We highly recommend to test this. If you do not there is the chance that upon configuration “fibre collisions” may occur and the night astronomer may have to de-allocate one or more fibres. You can check the validity of your fibre allocation over a range of hour angles using the Check over HA range option in the Commands menu.

3.9 Saving the configuration

Click on the Save Target Setup file button in the Basic sequence window. A file save dialogue will allow you to specify the name and location of the file to be written. The name of the file is generated automatically according to FLAMES conventions, and should not normally be changed. This file is a text file and can be printed or examined, but it should not be modified. Changes to the output Target Setup file, no matter how small, will cause it to be rejected by the observing system when the time comes to make use of it.

You should also be careful not to introduce changes to this file inadvertently. Some e-mail systems (Netscape is an example) feel entitled to modify text files in subtle ways. If you need to transfer such file you should pack it into a tar file and/or gzip it first, then transfer the tarred and/or gzip’ed file and untar and/or gunzip it on the receiving machine.

3.10 Exit the program

Click on the Exit button in the basic sequence window to exit the program.
4 Some additional features

This section describes in a relatively informal way some of the additional features of the program.

4.1 Using the Mimic window

A number of features are available as you move the cursor around the mimic window. Some of the more useful are as follows:

You can zoom in and out using the **Zoom** menu in the main panel, but you can also zoom in by a factor of two by clicking the right mouse button in the mimic window. You can zoom out by a factor of two by control-clicking the right mouse button in the mimic window.

As the cursor moves over a fibre, the fibre number and type are displayed in the top information pane of the window. If you click on a fibre, this selects the fibre. As the cursor moves over a target, the target name and type are displayed at the top of the window. If you click on an unallocated target, this selects the target. (It’s hard to click on an allocated target, because the fibre covers it and you select the fibre instead. In practice, however, you rarely want to select an allocated target – selecting the fibre is usually what you want to do.)

If you have selected an unallocated fibre and an unallocated target, you can use the **Allocate target** option in the **Commands** menu to allocate the selected fibre to the selected target. If you have selected an allocated fibre, you can use the **Deallocate fibre** option in the **Commands** menu to deallocate it. This allows you to impose your own choice of allocations if you really want to do so.

4.2 Different allocation algorithms

The program supports several different allocation algorithms, and these can all be run in a number of different ways. They are controlled by the options presented to the user by the dialogue box displayed when the **Allocate**... option is selected. These are described in detail later in this document.

4.3 Uncrossing fibres

It is possible to explicitly invoke a version of the allocation algorithm that only attempts to reassign already allocated fibres in order to reduce the number of crossovers of fibres. This can be done by selecting **Uncross fibres**... from the **Commands** menu. The fewer crossovers there are in a configuration the faster it is for the fibre positioner to reconfigure the field.
4.4 Multiple configurations to cover a target list

If you have a large number of targets – such as those in the sample input file N3201-00.fld in the directory test of the FPOSS installation – then you may want to try to create a number of configurations that will cover all of the targets. The program is not optimised for this mode of operation, but it may be implemented during future upgrades.

After a first configuration, which will, of course, only have allocated fibres to a small subset of the targets available, select the List… option from the File menu. A dialogue box will allow you to control what is written to the list file. Select the Unallocated objects option. This will produce a new target list that contains all guide and reference stars, all sky positions but only the unallocated targets. (All reference and guide stars and sky positions are included, even those allocated in the present configuration, since they can sensibly be reused in the next configuration). You are then prompted for the name and location of the new list file.

You can then select the Open Input file… option from the File menu and specify this new target list as the input file. You now have all the targets except for those non-guide targets allocated in the previous configuration. You can create a new allocation and repeat the process.

4.5 Viewing allocations using Skycat

You may want to see the allocated targets plotted against an image of the sky. In particular, if you have used the Generate Sky Grid command from the Commands menu to create sky positions you may want to check whether or not these really do represent blank sky. FPOSS can generate catalogue files in the standard ESO catalogue format containing all the allocated targets, and these can be read by the ESO SKYCAT program.

To do this, select the List… option from the File menu, and select the Allocated objects in Skycat format option from the dialogue box that comes up. You are then prompted for the name of the catalogue file to be written.

If you now run Skycat, you can read this newly created catalogue file as a local catalogue file. (Use the menu sequence Data-Servers -> Local Catalogs -> Load from file.) If you do so immediately after launching Skycat, with no image displayed, the Max Radius set to 0, Skycat will default to a display centred on the centre of the field that was allocated, and will show some of the allocated targets around the centre of the field. To get the allocated objects displayed on a sky image, use the Image servers sub-menu. (The usual menu sequence is: Data-Servers -> Image Servers -> Digitized Sky at ESO.) The centre of the field will already be set, but you should increase the size of the field to be somewhere in the range 25 to 30 arcmin, depending on how much of the field you want to see. An image will be retrieved from the image server and will be displayed. The allocated targets can be superimposed on it by pressing the Plot button in the local catalogue window.
By default, sky targets will be displayed as blue crosses, reference stars (FACB targets) will be displayed as red squares, the VLT guide star as a red diamond, and all other targets will be displayed as blue circles. The catalogue as written by FPOSS contains a text entry that describes the target type precisely, and numeric entries that indicate whether or not each target is a sky target or a reference target. There is one dummy target included in the catalogue, the first one listed, that indicates the centre of the field.

**IMPORTANT NOTE:** Service Mode users will have to prepare finding charts as part of their phase 2 preparation. It is recommended that these finding charts be prepared using the Finding Chart Maker implemented in p2. Alternative, the procedure described above using the Skycat package distributed with the FIMS software can be used. This includes a dedicated Finding Chart Plugin.

For further instructions on Finding Charts, please consult [https://www.eso.org/sci/observing/phase2/SMGuidelines/FindingCharts.FLAMES.html](https://www.eso.org/sci/observing/phase2/SMGuidelines/FindingCharts.FLAMES.html)
5 Detailed input file format

This section refers to the text file that is used the first time a set of targets are presented to FPOSS. The filename extension of these files is .fld. They are prepared by the astronomer – possibly using a purpose-built program to do so.

The file consists of lines of up to 256 characters. Comment lines can be indicated by an asterisk character (‘*’) or a hash character (‘#’) in the first column. At the start of the file, there should be a series of lines that describe the field itself, as opposed to the individual targets it contains. Special characters, particularly quotes, should be avoided. Each of these lines must begin with one of the following keywords (which may appear in any order):

- **LABEL**: It can be followed by any text (i.e. a string specifying the target field name). It does not have to be enclosed in quotes.
- **CENTRE**: It must be followed by the RA and Dec corresponding to the centre of your field (format: hh mm ss.ss [-]dd mm ss.s, where [-] indicates an optional sign.)
- **EQUINOX**: Optional. If supplied, must be followed by the string J2000.0
- **ARGUS**: Optional. If supplied (only when observing with ARGUS), must be followed by a position angle in degrees and a string specifying the ARGUS scale to be used as initial values, separated by a space. The scale string must be either ‘1:1’ or ‘1:1.67’ (the quote characters are not required). Note that when supplied, it does allow the setting of the position angle and the scale, however the Fibre Combination must still be selected in the usual way as described elsewhere in this document, because otherwise the Fibre Combination is interpreted as ‘NON_STANDARD’.

Any non-comment line that does not start with one of these keywords will be assumed to signal the start of the target list. Target objects are listed one per line. Each line consists of a number of items (columns) separated by spaces. The first five items are mandatory as follows:

- **Name**: The name of the object. Note that this cannot contain spaces.
- **RA**: hh mm ss.ss
- **Dec**: [-]dd mm ss.s
- **Type**: One character indicating the type of object (see below for the allowed types).
- **Priority**: (1-9) with 9 being the highest priority. If you are not using priorities you should set all priorities to the same value, say 1.
The program regards the following items as optional, but it may be useful to provide them anyway. In particular,Magnitude (in order to be able to filter your list of targets) and theComment(s) field, which is used to specify proper motion information. Any items not required must be filled in with an asterisk place-holder if any subsequent items are to be used.

**Magnitude** (mm.mm)

**Program Id**
An integer which uniquely identifies a specific project.
At present, this is ignored.

**Comment**
Embedded items followed by any remaining text up to the end of the line

### 5.1 Additional items embedded in comments

FPOSS allows to add a number of additional items of information about target objects to be included in the input file. These are included in the Comment field, and take the form of strings

(Name)=value

or

(Name=value)

These can be delimited by commas, blanks, or semi-colons, and should be at the start of the comment string. The following names are accepted within the parentheses.

**BAND**
Band designation for the magnitude specified (B,V,R)

**B-V**
Object colour index, B-V

**V-R**
Object colour index V-R

**PM-RA**
Annual right ascension proper motion for the equinox J2000 in the FK5 system in arcsec per year.

**PM-DEC**
Annual declination proper motion for the equinox J2000 in the FK5 system in arcsec per year.

**SNR**
Signal to noise ratio requested by the observer.

**CATEGORY**
Object morphology: Stellar or Extended

**DIAMETER**
Source extension diameter for extended objects, in arcmin.

### 5.2 Possible object types:

The following letters are accepted in the ‘Type’ field for an object:
M  Program object to be assigned to Medusa fibres from Giraffe.
I  Program object to be assigned to a GIRAFFE integrated field unit (IFU).
U  Program object to be assigned to a UVES fibre.
A  Sky target to be assigned to one of the Argus sky fibres.
J  Sky target to be assigned only to one of the IFU sky fibres.
S  Generic sky target (i.e. any position in the field that can be used for sky) to be assigned to any Medusa, IFU sky, ARGUS sky, or UVES fibre.
F  Reference star to be assigned to FACB.
G  Guide star. This indicates a guide star that can be used by the VLT guide probe. Fibres will not be assigned to such an object.

5.3 Example Text Input File

* This is a comment line
LABEL target field number 1 xyz cluster
CENTRE 12 43 23.30 +10 34 10.0
* end of required header info
*
F1  12 40 20.55 +10 30 11.4  F   6  12.0  1  (PM-RA)=0.01,(PM-DEC)=0.005 brightest star
F2  12 38 10.31 +09 59 58.9  f   6  13.5  1  (PM-RA)=-0.03,(PM-DEC)=0.13 fiducial star
*
NGC1002  12 41 30.55 +10 31 56.9  M 9  15.0  1  small fuzzy galaxy
ic3082  12 40 18.40 +10 32 21.5  M 9  *  1 candidate satellite
*
sky-1  12 40 10.00 +10 32 21.5  S 3  *  1 blank sky (checked)

Please note: Proper motion information, and any other embedded parameters in the comment field MUST be at the start of the comment field. Any actual comments must then follow these embedded parameters.
6 The FPOSS configuration program

This section is a more formal description of FPOSS the OSS configuration program, that is used to perform the following main functions:

- Performing the allocation of fibres to objects in a FLAMES field.
- Checking the validity of fibre allocations over a range of dates and hour angles.
- Generating a file describing the field configuration and allocations that can be used as input to the FLAMES observing system.

6.1 Running the FLAMES configuration program

The program is started with the command `configure` typed at the UNIX shell prompt. This will open three windows. The control window contains a menu bar, status display, and Message region. The largest window – the ‘mimic’ window – will be used to display a graphical representation of the FLAMES configuration being generated. The Basic sequence window provides a guide through a basic sequence of operations needed to generate a configuration for FLAMES.

6.2 Opening files

The configuration program can read data of two types only:

- Text files containing a description of the field in the standard format described earlier in this document. These are lists of targets and contain no fibre allocations. The default extension for these files is `.fld`.
- Target Setup files already containing fibre allocations created previously by the configuration program itself. The default extension for these files is `.ins`.

Note that an astronomer will always start by generating a text file describing the targets in a field, i.e. a `.fld` file.

To open a configuration text file select Open Input file... from the File menu and select your file using the file selection dialogue that appears. By default, a file extension of `.fld` is expected for configuration text files. Alternatively, select the Open Input file... option from the Basic sequence window. If an input file contains a large number of targets, you may want to set a magnitude filter first to restrict the targets considered by the program to those within the magnitude range specified. To do so, select the Magnitude Filter option from the Basic sequence window.
To open a Target Setup file (i.e. a previously created FPOSS setup file) select **Open Target Setup file**... from the **File** menu and select your file using the file selection dialogue that appears.

Upon opening your file the status display will show a summary of information about the field, and the objects in the field will be drawn in the mimic window. In the case of a text file no fibre allocations will be present, so the fibres will all appear in the mimic display at their park positions. A Target Setup file may already include fibre allocations and these will be shown on the display. To remove any existing allocations in order to start from scratch use **Remove Allocations** from the **Commands** menu.

### 6.3 Converting Files

The configuration program can be used as a way of converting configuration files between text (.fld) and output (.ins) formats, in either direction.

To convert a text configuration file to a Target Setup configuration file, use **Open Target Setup file**... from the **File** menu to open the file, then use **Save** or **Save As**... to save the file in its .ins format. This sequence can be performed non-interactively using the –d switch on the command line when configure is invoked.

To convert a Target Setup configuration file to a text file, use **Open Target Setup file**... from the **File** menu to open the file, then use **List**... to output the file in text format. The output file produced by **List**... is a valid configuration text file. It may be used, for instance, to list and save the unallocated objects from the configuration file. It may also include a listing of the fibre allocations in the form of comments in the listing.

### 6.4 Overview of the Allocation Procedure

You can automatically allocate fibres by selecting **Allocate**... from the **Commands** menu. This will bring up a dialogue box with a number of parameters controlling the allocation process. The default parameters will be suitable for most purposes. During the allocation process, which will typically take under a minute to complete, a progress window will report on the progress of the allocation, and the mimic window and status display will be updated as new fibres are allocated.

The default is to leave no fibres unallocated if possible, but you can specify a number of fibres to be left unallocated for sky targets. Once the object allocation is complete you can assign these to sky positions. These can either be generated on a standard grid (using **Allocate Sky Grid**... from the **Commands** menu) or they can be supplied in the input file. Alternatively, you can add sky positions manually.
Once the allocation is complete, it will be checked for validity at the current position. As an extra step, you should select **Check Over HA Range** from the **Commands** menu to check the validity of the field over a range of hour angles (the default is to check for plus and minus four hours from the meridian).

Saving the configuration as your Target Setup file will now give you an input file for the FLAMES positioner. You should ensure that all the available FACB guide fibres were selected.

### 6.5 The Allocation Procedure in more detail

The above recipe will suffice for the majority of fields. The hardware constrains the fibres to an angular limit from the radial direction which is instrument-dependent, but fibres are allowed to cross multiple times and in most cases all of them can be allocated to targets.

#### 6.5.1 The ‘Oxford’ algorithm

The algorithm currently used for 2dF (developed by Gavin Dalton at the University of Oxford) is highly optimised and has proved to give the best results for ‘typical’ fields. This algorithm is invoked by selecting the **iterative target allocation** option from the allocation dialogue. After an initial allocation it searches down a tree of multiple fibre swaps, looking for swaps that give increased allocations. The algorithm is not unlike a chess program. The tree search terminates at a depth of ten swaps where it has been found, empirically, that the expenditure of CPU time required to deepen the search is not rewarded by increased allocations.

The algorithm handles objects of different priorities by trying to allocate the highest priority objects first. During the swapping process it will continue to search until it becomes possible to allocate a fibre that was previously parked, or it becomes possible to promote an allocated fibre to a higher priority object.

After the swapping phase there is a final ‘uncrossing’ pass which looks at all pairs of fibres which cross to see if they can be reversed. This is important, as reducing the number of fibre crossings in the final configuration produces a significant reduction in the field setup time by reducing the number of fibres that must be parked in transit, but this reduction is provided without constraining the allocation itself.

The **tentative deallocation** option presented in the allocation dialogue does not apply to the Oxford algorithm.
At present, the Oxford algorithm is very slow when the number of targets greatly exceeds the number of fibres. If you have such a field, you should use the ‘Taylor’ algorithm instead.

6.5.2 The ‘Taylor’ algorithm

For fields with a large number of target objects – far more than the number of fibres – the swapping phase of the iterative target algorithm can take too long for that algorithm to be used successfully. For such fields, better results are obtained by an algorithm developed by Keith Taylor. This operates in a number of different modes, and is invoked by selecting **by most crowded, by hardest target or by straightest target** in the allocation dialogue.

This algorithm is relatively easy to understand. It assumes that the hardest pivots to allocate will be those that can be allocated (on grounds of physical constraints, such as fibre bend angle, fibre length, etc. and target/fibre compatibility) to the fewest targets. It therefore allocates the pivots to targets in order of decreasing difficulty, starting with the hardest pivot to allocate. Having decided which pivot to allocate, it then has to pick a target for it. It will allocate the highest priority target available for that pivot. If more than one target of the same priority can be allocated, then the decision depends on just how the algorithm was invoked.

If **by hardest target** is selected, it picks the target that can be assigned to the fewest fibres. These targets are going to be hard to allocate, so it tries to allocate them as soon as possible.

If **by most crowded** is selected, it picks the possible target with the least average distance to other targets. This is suitable for fields that have areas that are particularly crowded, and in particular, for cases where the user is trying to get a number of configurations that will, together, cover a large target list. (The ‘hardest target’ option will often allocate a greater number of targets for a single configuration, but will do so by ignoring crowded targets, leaving these to be covered by the final configurations in a set, which is unsatisfactory.)

If **by straightest target** is selected, it picks the target that will bend the fibre the least. This option produces allocations with the minimal number of crossed fibres, which can be a consideration if exposure times are small and it is important to be able to reconfigure the field as quickly as possible.

If **tentative deallocation** is selected in the allocation dialogue, the algorithm performs a pass where it tentatively deallocates each allocated fibre in turn and then sees if this allows more than one other allocation to be made. If so, there has been a gain from this deallocation. The option takes a little time, but can often squeeze a few extra allocations out of a field.

Uncrossing is not supported at the moment if the Taylor algorithm is being used. However, it is possible to make an allocation using the Taylor algorithm and then select **Uncross**
fibres... from the Commands menu. This invokes a modified and relatively fast form of the Oxford algorithm that only performs the uncrossing pass.

6.6 Target Priorities

The targets are allocated in order of priority, with a numerical value of 9 being the highest priority and 1 being the lowest. To ensure all guide fibres are allocated it is best to give guide targets the very highest priority values.

6.7 The allocation window

When Allocate... is selected from the Commands menu, the allocation window appears. This allows you to control the details of the allocation procedure. The window is shown in Figure 19.

The parameters here control the various steps of the allocation. The default is to allocate the maximum number of targets and optionally leave a number of fibres for subsequent sky allocation.

- **Target selection** allows the selection of the allocation algorithm as described in the previous section on the details of the allocation algorithms.

- **Fibre uncrossing** controls aspects of the fibre uncrossing scheme. The default is to uncross at the end of the allocation, which will suffice for most fields. If there are many priority levels of object, one can sometimes gain in allocations by selecting uncrossing after each priority pass, though this is more time consuming. It is also possible to uncross existing configurations either here or by selecting Uncross Fibres in the Commands menu and then proceed to allocate extra objects without removing the existing allocations.

6.8 Sky Fibres

It is important to have sufficient sky fibres allocated.

You can supply sky positions in the input catalog – for example, positions that have been carefully checked on images to ensure absence of bright objects. To assign to these, make sure that you have suitable values set in the boxes in the allocation dialogue that allow you to specify the number of fibres of each type that are to be allocated to sky targets.

If you do not have sky positions in your input catalog, you should still use the same boxes in the allocation dialogue that allow you to specify the number of fibres of each type that are
to be allocated to sky targets. If there are no sky targets at all in the target list, the specified number of fibres of each type will be left unallocated in the normal allocation process. You may then create a grid of sky positions and allocate these positions automatically by selecting **Allocate Sky Grid**... from the **Commands** menu.

Finally, arbitrary sky positions can be assigned interactively (see below).

It may be desirable to check the positioning of sky fibres that have been automatically allocated or added by hand, to ensure that these are not contaminated by stray objects, particularly brighter stars. This can be done by selecting **List**... from the **Commands** menu, and checking the **Allocated Sky as DSS input** button. This will list all allocated sky positions as J2000 coordinates to a file (the default file name is the same as that of the input file, but with the extension .dss) which is in the correct format to be read by the commonly available StScI getimage program. The sky positions are named Snnn in the .dss file, where nnn is the fibre number. The content of the sky fibres can then be conveniently checked using a FITS aware visual browser (eg the visual schnauzer in xv).

### 6.9 Manual Allocation of Fibres

It is also possible to manually allocate individual fibres to objects. If you are using a priority scheme for allocating targets then you can highlight all allocated or unallocated targets within a given range of priorities using the **Highlight Targets**... option in the **View** menu.

Manual allocation is performed by interacting with the mimic display as follows:

- Select a fibre by clicking on its button – it will be highlighted in blue.

- Select an object by clicking on it – it will also be highlighted in blue.

- Select **Allocate Fibre** from the **Commands** menu.

The validity of the resulting configuration will be checked, and a progress dialogue will be displayed as this happens. If the resulting configuration is valid the allocation will be made and the display updated. If it is not valid, an error dialogue will appear.

There is a short cut in the manual allocation procedure that avoids the use of the menu as follows:

- Select a fibre by clicking on its button.

- Move the cursor over the desired object and click the middle mouse button.
It is possible to manually allocate fibres and then select **uncross first then allocate extras** in the allocation dialogue window to automatically assign the rest of the fibres while preserving the manual allocation.

It is also possible to deallocate fibres manually as follows:

- Select a fibre by clicking on its button. You need to position the cursor carefully to ensure you select the fibre rather than the object. Make sure the fibre button is highlighted in red. This operation is easier if the display is zoomed.

- Select **Deallocate Fibre** from the **Commands** menu.

Sky positions, either included in the input configuration file or generated as a sky grid, are allocated in the same way as objects. However, there is an additional facility that allows you to create an arbitrary sky position anywhere in the field. To do this, select a fibre in the normal way with the left mouse button. To assign it to a sky position use CTRL + middle mouse button. This creates a sky target in the configuration under the cursor and attempts to assign a fibre to it and is most useful for assigning miscellaneous unallocated fibres to nominal sky positions.

### 6.10 The Mimic Display

The display can be zoomed to magnifications of 2, 4, or 8 times its normal scale using the **Zoom** menu. The zoomed display can be scrolled using the scroll bars.

It is also possible to zoom the display by a factor of two about any selected point by clicking the right mouse button with the cursor positioned at the desired centre.

In the display, reference stars are shown as large open squares, target objects as small black open circles and sky targets as light blue open diamonds. VLT guide stars are shown as large blue open circles. Fibre buttons are shown in different colours to distinguish between different fibre types. Disabled or non-existent fibres are shown in grey. Selected objects and fibre buttons are shown in blue. Information about individual objects or fibres in the display can be examined by double clicking on the objects or fibre buttons.

To locate an arbitrary fibre button enter the pivot number in the fibre information popup (which comes up when any fibre is double clicked on) and press return – this selects the requested fibre.

The display can be printed by selecting the **Print...** command from the **File** menu. A postscript version of the mimic window will be generated which can either be sent directly to a printer or saved as a file, according to selections in the resulting dialogue box.
6.11 Saving a Configuration

After completing the allocation process and checking its validity, the resulting configuration can be saved as your Target Setup file (.ins) by using **Save** or **Save as Target Setup file...** from the **File** menu. The resulting file is in a format suitable for use by the FLAMES observing system.

A text file listing the fibre allocations and/or the unallocated objects can be obtained by selecting the **List...** option from the **File** menu.

6.12 Command Line Switches

Only one command line option is normally used when running configure:

- **-f filename** Specifies the initial input file (either .fld or a .ins file).

6.13 Reference

You will find detailed descriptions of most terms in the P2 user manual [2] including a glossary and a discussion on Observation Blocks.
7 The Menus in detail

This section describes the menu contents for all the menus available in the main control panel – the File, View, Options, Commands, and Zoom menus. All the features of the program are available through these menus.

7.1 The File menu

Figure 1 shows the File menu.

```
Open input file ... (^O)
Open Target Setup file...
Save Target Setup file...
List...
Print...
Exit ^E
```

**Figure 1 The File menu**

Open input file  
Opens a file selection dialogue to read in a new list of targets from a text input file (.fld). If a file is already open and has not yet been saved, you will be asked if you want to save it before opening the new file.

Open Target Setup file  
Opens a file selection dialogue to open a file saved as the result of a previous configuration of FPOSS. This will put the program back to the state it was in when that file was saved, at least so far as fibre allocations and VLT guide probe settings are concerned. These files are not normally saved with details of unallocated targets included, so this information will not normally be restored. If a file is already open and has not yet been saved, you will be asked if you want to save it before opening the new file.

Save as Target Setup file  
Opens a file selection dialogue allowing you to save the details of the current configuration (.ins).

List…  
Opens a dialogue box allowing you to specify what details should be included in the list file to be created, and then opens a file selection dialogue box to allow
you to specify the name of the list file. This can be used to generate catalogues that can be read by Skycat or to be used as input to subsequent configurations.

Print… Creates a printed version of the mimic display window.

Exit Exits the program.

7.2 The View menu

Figure 2 shows the View menu.

Select Targets… Opens a dialogue that allows you to highlight target objects of different types. For example, you can choose to highlight targets in a given priority range, or targets that are classified as UVES targets. Highlighting is quite subtle and if there are a large number of targets even a highlighted target may not show up sufficiently. So this dialogue also allows you to redraw the mimic display with all targets magnified. It also has an option that indicates all highlighted targets with large blue arrows – the result is unsubtle, but quite obvious.

Use grey shades for display Switches from using colours to differentiate between fibre types to using different shades of grey. Some users find it easier to distinguish shades of grey rather than colours. This option is only active if grey shades are not already being used.

Use colours for display Switches from using different shades of grey to differentiate between fibre types to using colours. Most users find it easier to distinguish colours rather than shades of grey. This option is only active if colours are not already being used.
Show Argus settings This opens a dialogue allowing you to specify the ARGUS position angle, in degrees, and to choose between the two different ARGUS scale factors (1:1 or 1:1.67). If you change the position angle, this will invalidate any current allocations and will cause recalculation of all the target positions.

7.3 The Options Menu

Figure 3 shows the Options menu.

![Image of Options menu]

**Figure 3 The Options menu**
The options menu provides control over a number of possible options for the program.

- **Set magnitude filter**... Opens a dialogue box that allows you to change the magnitude range used to filter the input target list.
- **Change Field Label** Allows the label for the field to be changed.
- **Select Fibre Combination** Opens a menu showing all the fibre combinations supported by the instrument, allowing one such combination to be specified for use when fibres are allocated. This allows the same input configuration file to be used to generate a number of different configurations depending on which instruments are in use.

7.4 The Commands Menu

Figure 4 shows the Commands menu.
Allocate... (F4)
Auto-Reallocate...
Check Allocation
Check over HA range...(F2)
Generate Sky Grid...
Uncross Fibres...
Set Hour Angle...
Remove Allocations...
Allocate Fibre (F3)
Deallocate Fibre (Del)
Show Fibre Info...
Set field center...
Deallocate Broken Fibres
Deallocate Sky Fibres

Figure 4 The Commands menu

The Commands menu allows you to invoke most of the operations that FPOSS can perform.

Allocate
Performs a complete fibre allocation. It opens the allocation dialogue that allows you to modify the parameters used by the allocation algorithm, and then starts the allocation process.

Auto-reallocate
Invokes the allocation algorithm in a mode where it modifies the current allocation to allow for broken fibres. This is useful when an existing allocation has been read in from an SDS file but the instrument setup has changed since the allocation was made.

Check Allocation
Performs a validity check on the current allocation. This is useful when an existing allocation may have become invalid – for example, because the observation time has been modified.

Check Over HA range
Opens a dialogue allowing you to check the current allocation over a range of dates and hour angles.

Allocate Sky Grid
Automatically allocates a grid of sky targets. This is an alternative to providing a specific set of sky targets in the input target file, but of course the program has no way of knowing what parts of the target field are really clear and suitable for use as sky.
Uncross Fibres
Invokes the allocation algorithm in a mode that merely attempts to exchange fibre/target allocations in such a way as to minimise the number of fibre crossings.

Set Hour Angle
Opens a dialogue box allowing you to specify the hour angle for the observation. After a change such as this you should check the validity of the allocation (if there is one) using Check Allocation.

Remove Allocations
Removes all the current fibre/target allocations, if any. A dialogue box opens asking you to confirm that you want this doing.

Allocate fibre
This is only active if a fibre has been selected (by clicking on it in the mimic display) and a target has been selected (also by clicking on it in the mimic display). It causes that fibre/target allocation to be made and verified. This can be useful as a check on why the algorithm did not make what appears to be an obvious allocation – select the fibre and target in question and use this option to allocate them explicitly. You will often get an error message explaining why the allocation cannot be made.

Deallocate fibre
Only active if a fibre has been selected (by clicking on it in the mimic display). If the selected fibre has been allocated to a target, this causes it to be deallocated and returned to its park position.

Show fibre info
Only active if a fibre has been selected (by clicking on it in the mimic display). Opens a window giving details about the fibre.

Set field center
Moves the field center so that the field is now centered at the place last clicked on the mimic display. So the idea is that you click on the mimic display at the required field center, then select this menu option. A dialogue box opens asking you to confirm this change. This change will invalidate any current configuration.

Deallocate Broken Fibres
Removes any allocations that involve broken fibres. You can only get such an allocation by reading in a configuration (from an SDS or PAF file) that was made with a different instrumental setup file.

Deallocate Sky Fibres
Removes any allocations that involve sky targets. (The name of the menu item is a little misleading – it is the
target that is sky, rather than the fibre, although it is true, for example, that all ARGUS fibres are sky fibres.)

7.5 The Zoom menu

Figure 5 shows the Zoom menu.

![Figure 5 The Zoom menu]

This menu permits you to zoom the mimic display according to a range of scale factors. You can reduce the image size, as well as expand it from the usual size. The zoom menu just presents a set of 6 zoom values that are generally useful. More extreme values can be obtained by right-clicking in the mimic display. (Note that there is no dialogue that allows a completely arbitrary zoom factor to be specified.)
8 Appendix A: A tour of FPOSS

You should try this out using the test configuration file supplied with the program. A number of test files are supplied with the configuration. For your first tour through the program, you should use the supplied file N3201-00.fld. This is a fairly typical input file. This section may seem quite long, but that is mainly because it has a lot of screen shots in it. Actually running through the tour should only take a few minutes.

8.1 Starting up

The configuration program is invoked in the same way as any UNIX program, by typing its path name and appending any necessary parameters. For the purposes of this tour, it is convenient if you set your current working directory to the directory <installation-directory>/FPOSS/test. Then if the FPOSS bin directory is in the user’s PATH, (see section 3.3) all that is required is the command:

`configure &`

(The trailing & runs the program in the background, which is usually convenient. If the the FPOSS bin directory is not in the PATH, then ‘../bin/configure &’ should work.)

The program will start up, displaying three windows. There will be a main control panel (Figure 7 – please be aware that the version number appearing on the top bar of the figure will reflect the most current version of the tool) and a window that will eventually show a ‘mimic’ display of the field plate with targets and fibres. Initially, this will just show a number of concentric circles of varying radii (Figure 8). There will also be a Basic sequence window that is intended to guide you through the program (Figure 6).

Let’s take a quick look at each of these windows, although at the moment they aren’t very interesting.
For most uses of FPOSS, you will be able to control the configuration process almost entirely from the basic sequence window. The idea is that you press each of the buttons down the left hand side of the window in sequence. That is what we will do first in this tour of the program. Later we will look at some of the other options, using the menus in the main control panel.

**Figure 6 The Basic Sequence window**

<table>
<thead>
<tr>
<th>Button</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Magnitude filter</td>
<td>Input target list is not being filtered</td>
</tr>
<tr>
<td>Open input file</td>
<td>Not selected</td>
</tr>
<tr>
<td>Select guide star</td>
<td>NON_STANDARD (all selected)</td>
</tr>
<tr>
<td>Fibre combination</td>
<td>No fibres allocated</td>
</tr>
<tr>
<td>Allocate fibres</td>
<td>Not checked</td>
</tr>
<tr>
<td>Check HA range</td>
<td>Not saved</td>
</tr>
<tr>
<td>Save Target Setup file</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>
The control panel contains a number of menus, and a large number of fields where information can be displayed, together with a scrolling region at the bottom for messages. Note that the fields are not editable, even though they might look like it.

![Image of the control panel]

**Figure 7 The control panel**
The initial mimic display

The mimic display at present only shows a number of concentric circles. If you move the cursor over these, the left part of the status bar at the top of the window will tell you what they are. The black circle at the center is ARGUS. (Actually, ARGUS is rectangular, but the field plates have a circular hole in the middle to allow for ARGUS, and this hole (where fibres cannot be placed, of course) is circular. The yellow circle marks the 20 arcminute diameter circle, the blue circle marks the 25 arcminute diameter circle, the furthest out that a fibre can be placed. The black circle marks the pivot circle – the point where the fibres emerge from their retractors around the field plate. The red circle marks the 28 arcminute diameter – VLT guide stars should not be chosen outside this red circle and to avoid vignetting of the VLT guide star by the M3 tower they should be chosen inside the 25 arcminute diameter circle.
8.2 Setting a magnitude filter

For files that have a large number of targets you will probably want to set a magnitude filter to reduce the number of targets to a manageable number. This is certainly true of the N3201-00.fld test file, which contains thousands of targets. (So many that if you try to open it without having set a magnitude filter the program will warn you about it.)

So, this is where we start out through the basic sequence window. Click on the **Magnitude Filter** button. A dialogue window will open prompting you to set a magnitude filter range.

![Magnitude Filter Dialogue Box]

*Figure 9 Magnitude filter dialogue box*

For the N3201-00.fld test file, selecting a magnitude range between 12 and 17 will give a suitable sample of targets for our purposes. Fill in the two entry boxes and click on the **Apply** button. Once you do that, the dialogue box changes to indicate the new settings.
You can now click the **Close** button and the dialogue box will close. You will find that the basic sequence dialogue window has changed to reflect what you have just done.

You can now click the **Close** button and the dialogue box will close. You will find that the basic sequence dialogue window has changed to reflect what you have just done.

You can now click the **Close** button and the dialogue box will close. You will find that the basic sequence dialogue window has changed to reflect what you have just done.

The line to the right of the magnitude filter button now indicates the magnitude filtering you specified, and there is a small red tick to the immediate right of the button. As you work through the basic sequence, each item should get ticked to indicate your progress.
8.3 Opening the data file

Now click on the **Open Input file button** in the basic sequence window. This will bring up a file selection dialogue box. This will look something like this, depending on what files you have in your directory:

![Open file selection](image)

Select N3201-00.fld and click on the Open button. Now things start to happen. The target list in this file will be read in, filtered for targets between 12\text{m} and 17\text{m} magnitude, and the
program now has something to display on the mimic window. You will also notice that there is information at last in the various fields of the main control panel.

![Control panel with file open](image)

**Figure 13 Control panel with file open**
As shown above in Figure 13, the details of the field are now displayed in the main panel, which will now show the number of targets, classified into ‘program targets’, ‘sky positions’ and ‘reference stars’. For FLAMES, ‘program targets’ includes Medusa, IFU, UVES and ARGUS targets, while ‘reference stars’ includes both VLT guide stars (which cannot in fact be allocated to fibres) and FACB guide fibre targets. Sky includes anything designated as a sky target.

Now that a configuration file has been read in, the targets are displayed in the mimic window, and the fibre positions are drawn, as shown in Figure 14. Since no fibres are allocated as yet, all the fibres are shown at their park positions, just outside the 25 arc-minute diameter, shown as a blue circle on the mimic display. The other two circles drawn in the mimic display show the 20 arc-minute diameter circle (in yellow) and the 28 arc-minute diameter (in red). A compass at the top-right of the display shows the East and North directions, and the instrument is displayed in the top left corner. The black circle at the centre of the display shows the position of ARGUS. The orientation of the display is the default orientation, with East to the top and North to the right. If the input file contains a line specifying an ARGUS position angle (which the N3201-00.fld file does not) then the field orientation may differ.

There are a number of different types of fibres used by FLAMES, and each type is shown in a different colour, although these are not always easy to distinguish. If you place the cursor on top of a fibre the fibre type is displayed in the top information bar of the mimic panel.

Note that other features of the mimic display, such as the meaning of the circles, are identified in the same way by moving the cursor upon them. The information appears in the top information bar.
8.4 Selecting the VLT guide star

The next item in the basic sequence window is Select guide star. The VLT guide star is used for both the VLT guiding and the VLT adaptive optics system. You must have such a guide star selected, or FPOSS will not allow you to save your configuration. The star should be isolated and ideally have an R-band magnitude of between ~9-11 (see the FLAMES user manual for details. For ARGUS observations, stars up to R=12 mag are possible if they are selected closer to the center of the field of view). The input file identifies such guide star targets as type G and they are shown in dark blue on the mimic display,
drawn rather more solidly than the other targets. The test field has one between the 20 and 25 arcminute circles, at about 1 o'clock. We will use this one for the purposes of this tour although the magnitude is fainter than optimal.

(If you have difficulty distinguishing the different target types, there are a few features built into the program to help – some users may find a grey-scale display easier to work with, and there is a menu that can be used to highlight targets of various types. This is described in more detail in Section 7.2. For the moment, this particular guide star should be easy enough to find.)

If you click on the Select guide star button in the basic sequence window, all you get is a message telling you to double click on a VLT guide star. The program can't do this for you, or even put up a dialogue to help. You have to double click on the guide star you want to use. If you double click on any target star, FPOSS opens a window giving details about the target. If the target is a VLT guide star, FPOSS also opens two circles that represent the two possible positions for the VLT guide probe pivot if it is to be assigned to that particular target star. If you double click on that guide star at 1 o'clock, the mimic display will show these, as in Figure 16.

The target information window that also pops up is shown in Figure 15. You don’t really need this at the moment, so you might as well just click the Cancel button which will close it. If you don’t see the two pivot positions appear in the mimic display, you should check that the target type shown really is VLT Guide star. If it isn’t, you selected the wrong target.

![Figure 15 Target information window](image-url)

Note that the guide star is fainter than optimal.
Click on one of the two filled blue circles indicating the two pivot positions. You will see the shadow of the VLT guide probe drawn in the display. You can click on the other circle to change to the other position for the probe. Once you click on one of the pivot circles, that selects the probe position and that is all you need to do. If you want to change to another guide star, double click on it and repeat the process.

For the moment, let’s assume you choose the upper pivot position and click on it. The mimic display will show this as in Figure 17. Because the guide probe needs to intercept the light from its target star it has to be above the field plate and so no light will reach fibres below
the guide probe. This means that there is a large guide probe ‘shadow’ on the plate, and target objects in this shadow region cannot be observed.

You can see that there are advantages to having the guide probe target as close as possible to the edge of the field. Targets under the guide probe shadow cannot be used and fibres will not be allocated to them. If you click again on the same pivot position, the guide probe shadow changes to an outline – this allows targets under the shadow to be selected using the mouse, something that is mainly useful if there is an alternative guide probe target in the shadowed area.
8.5 Selecting the Fibre combination

There are only a limited number of valid fibre combinations that can be used with FLAMES, and you need to select one of them. Click on the **Fibre combination** button in the basic sequence window, and the following dialogue will appear:
You need to select one of the allowed combinations. For the moment, select 'Medusa + UVES'. Click on the radio button (the diamond) to the left of the line that says **Medusa + UVES (8 fibres) [580,860nm]** and click on the **Apply** button.
If you select a fibre combination that includes ARGUS sky fibres, you will be presented with a dialogue box that asks you to specify the ARGUS scale factor and position angle.

The mimic display will change once you click the **Apply** button. All the fibres except for those of the type selected are removed from the display, and the fibre colours change. Now that there are fewer fibre types in use, a different set of colours are used. The main fibre type (Medusa) is now drawn in red, and the secondary type (UVES) is drawn in blue. For all combinations, guide fibres (the FACBs) are automatically included, and these are shown in green.

Now, we are in a position to allocate fibres to targets

### 8.6 Performing the Allocation

Click on the **Allocate** button in the basic sequence window. You will get a dialogue box that presents you with a number of options that can be used to control the details of the allocation algorithm.

![Allocation dialogue](image)

**Figure 19 Allocation dialogue**
If you accept the default options and click the OK button, the allocation process will begin. A progress box will be displayed giving some indication of what is going on, and eventually the allocation will complete. As fibres are allocated, they are drawn in their allocated positions on the mimic display, and the final result will look something like this:

![Figure 20 Allocation completed](image-url)

And that's it. One field allocated. However, before we can save it, it is highly recommended to check the allocations over a range in Hour angle, and that's the next step in the basic sequence.
8.7 Checking the Allocation Validity

The allocation process results in a fibre configuration which is valid at a single time. However, small changes in the relative positions of objects as a result of refraction and other effects could make this configuration invalid at other times and different telescope positions.

When FPOSS creates configurations, it does so by default using a set of tolerances for such things as button clearances that are more restrictive than those actually used by the positioner. These have been chosen so that in most cases tested, a configuration was valid (i.e. would not be rejected by the positioner) over more than a +/- 4 hour range in Hour angle.

However, it is highly recommended (and required for the preparation of Service Mode phase 2 material) to make this check as part of the preparation of your fibre configurations to ensure the validity of the fields at execution time at the telescope.

To do so, click on **Check HA range** in the basic sequence window which is equivalent to the **Check over HA range...** option in the **Commands** menu. It performs a default check that a fibre configuration remains valid over a ±4 hour range of telescope hour angles (and a range of dates). The check should run through with ‘Allocation OK’ reported in the Message region for each position tested. Occasionally one or two fibres or buttons that are OK at the meridian will cause collisions at larger hour angles. The simplest procedure is either to reduce the valid hour angle range or to manually reassign these as extra sky fibres, although it is usually possible to manually adjust the configuration to preserve the target allocation while removing the collisions. An option in the **Check over HA range...** dialogue can be used to get FPOSS to attempt this reallocation automatically.
The configuration produced by the allocation sequence just worked through passes this default test and the fibre configuration could be saved as a Target Setup file as will be explained in the next section.

However, to demonstrate the effect of a fibre-fibre collision, we first re-run the test with an extreme hour angle range of ±6.5 hours. In this case the test fails because one rogue fibre that is positioned rather close to a button moves just close enough to be counted as a collision for the extreme hour angle values. If you run this validity test you get:

![Error (Configure) 1](image)

**Figure 22 Hour angle test fails**

By running the cursor over the fibres, you can easily pick up fibres 224 and 226, and you can see that the button on fibre 226 is indeed allocated rather closely to fibre 224. The easiest thing to make the field valid over the requested hour angle range is to click on fibre 224 and then select the **Deallocate fibre** command from the **Commands** menu (or hit the **Delete** key on your keyboard). If you run the test with the **Attempt to reallocate invalid fibres** button checked this has the same effect. If you run now again the check over the hour angle you will find that the fibre allocations are valid even for the extreme hour angle range of ±6.5 hours which basically means that the field could be observed from horizon to horizon.

Now you are ready to save your checked fibre allocation as a Target Setup file.

### 8.8 Saving the allocation

Click on **Save Target Setup file** in the basic sequence window, and you get a standard file save dialogue. The file name is generated automatically according to FLAMES conventions, and you should not normally need to change it. However, you will need to note it down because this will have to be supplied to P2. The file name is based on the label for the field, the fibre combination in use, and the time of day. This ensures that a unique, informative, name is used for the file.

Click on the **Save** button, and the file will be written.
And that has completed a basic run through FPOSS. The Basic sequence window should now look roughly as follows:

You have got everything ticked. Well done!. Now you can exit the program using the Exit button, or you can go back to the start and perform a new configuration with a new input file. Finally, remember that you should not edit your .ins file as it now contains a checksum. Editing will cause this file to be rejected by P2 and you will have to repeat your work!.

--- End of document ---